
What is Easy Uploads?
Easy Uploads is a Windows utility to help save you time and money when uploading ("Contributing") files 
to CompuServe Libraries using WinCIM or CSNav.    Easy Uploads also helps insure that Descriptions, 
Titles, and Keywords for your files are consistent across all the Libraries you decide to place them on. 
Then, to help you remember where you placed them, Easy Uploads includes a Forum Tracker.    

Why Easy Uploads?

I'm not sure how you've been doing it, but until now, every time I wanted to upload a new file, or an 
update to an existing file, I was always spending way too much time typing, and would wrack my brain 
trying to remember the description I used the last time.

Sure, I would use Notepad, or Write to compose my thoughts beforehand, but there was never any way to
get all the data over to the File Description in one clean shot, and Pasting was really difficult (since the 
Library Contribute dialog box is modal [focus cannot shift until the dialog is closed], you cannot get at Paste in the Edit menu).    By 
the time I was ready to upload the file, I inevitably had one or two overlooked typos, and had spent a good
5 minutes getting everything just right. Forget it!

So I thought I'd buy CS Navigator, so I wouldn't have to retype all the data every time.    I'd create my 
script once, and then forget about it, because CSNav lets you do everything off line, right? WRONG!    
While still a great program overall, much to my surprise, CSNav DOES NOT save the data for 
Contributing Files with your Script.    You must still type your Title, Keywords, Descriptions, etc. every time.
Forget it!    

Don't get me wrong, they're both great programs, but I have a lot of files to update, and I don't want to do 
all that typing!    I suppose it would have been easier if I could have found something already on the 
Shareware market, but none could be found, so I built my own.    As probably one of its biggest users, you
can be sure that I will continue to improve it, until it's as easy as it can be!    Your suggestions to help 
attain that goal are always appreciated.

The Solution to My Problems

I created Easy Uploads.    With Easy Uploads, you create a simple text file with all your upload data, 
before that scary "Contribute" dialogs confronts you!    This gives you a chance to spell check your work, 
and give it a good going over, without the pressure of being on-line, and incurring connect charges, or 
constantly fiddling with the Description.    The text file uses the Windows INI format, so it's easy to 
understand and create.    In fact, all the data for the Easy Uploads descriptions on CompuServe Forums 
were entered using Easy Uploads (obvious right, I mean I certainly wouldn't create this great utility, and 
then type in all the data!).    Most uploads required less than 10 mouse clicks, and were begun within 10 
seconds of entering a Forum with WinCIM, and filling the Contribute dialog in CSNav is a snap!

For WinCIM
Once you get on-line, and in a Forum Library, you can start uploading your file within seconds of 
beginning connect charges $$$.    With Easy Uploads, once you're in a Forum, you can upload a file with 
as little as three clicks of the mouse!    See: Uploading Files to WinCIM.

For CSNav
CSNav already helps you save $$$ in connect charges, however by using Easy Uploads you can quit 
busting your knuckles typing your descriptions every time.    See: Uploading Files to CSNav.

Convenience Counts

Easy Uploads has an "On Top" check box to toggle its state between normal Windows behavior, and 



always staying on top of other applications.    When "On Top" is enabled, Easy Uploads will float above 
WinCIM/CSNav, so you don't have to use <ALT+TAB>, or minimize/maximize the programs to get at all 
the buttons.    

Size Counts

We all know that size counts.    When you want the best performance while uploading files, you know to 
close as many programs as possible, and give WinCIM/CSNav as much of your precious memory as 
possible, to effect a quick and error free transfer.    With that in mind, I have created Easy Uploads with as 
few resources as possible to keep it small and efficient.    Once it's copied your data to the Contribute 
dialog, you can close Easy Uploads, or let it sit minimized and unassuming, waiting to copy data for the 
same, or a new file, whenever you're ready again.    Simply click on an Easy Upload Data File, in the file 
list, and you're instantly ready to upload another file!
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Creating/Editing Upload Data Files
Select New to begin a New data File.    Easy Uploads will prompt you for a filename to give your data file, 
and then display a standard Open Dialog so you can specify the Source file you'd like to Upload.    Select 
a File, and Easy Uploads will place the Full Path in the File Name box, and the File Name in the 
Destination box.    If it finds a FILE_ID.DIZ file in your source directory, Easy Uploads will ask if you'd like 
to read it into the Description, to get a quick head start!    Then simply enter data in the appropriate fields.  
Enter the data just as you would if you were entering it to the Contribute dialog.    Create an Easy Uploads
data file for every program in your arsenal!

DATA FILE FORMAT
NOTE: The following assumes that you've already uploaded at least one file to CIS, and are familiar with 
the standard "Contribute" dialog.    The Easy Uploads data files use the standard Windows INI format.    

For Easy Uploads, a data file (INI) has the following parameters, shown in bold:

[UPLOAD]
FileName= Enter the FULL Path and Filename.
DestinationName= the Filename to use on CompuServe (6 chr. max + ext.)
Title= Your Program Title
Keys= Search Keys for your Program.
Library= Forum Library Number (0-23)    Use the actual offset in

the Forum List, not what the forum "says". 
HINT: count the # of {DN} key presses it takes to 
highlight the proper library. (0-23=1-24)

Description1= program description (up to 256 chr.)
Description2= program description (up to 256 chr.)
Description3= program description (up to 256 chr.)

[FORUMS]
Forum0= The name of a Forum specified by Forum Tracker
Forum1= etc

The data for the WinCIM dialog above was entered using Easy Uploads, and the following data file.



[UPLOAD]
FileName=C:\EASYUP\EASYUP.ZIP
DestinationName=EASYUP.ZIP
Title=Easy Uploads DEMO - DO NOT POST!
Keys=EASY UPLOADS CIS WINCIM CIM CSNAV NAVIGATOR CONTRIBUTE UPLOAD
Library=5
Description1=Save Time/Money Uploading Files To CIS. Now works with WinCIM AND 
CSNav, and includes "Forum Tracker", and "ZIP Viewer"! Easy Uploads allows you to specify 
data for your programs in a
Description2=text file, and then you can fill the "Contribute" dialog in WinCIM/CSNav in 
seconds, time after time! Whether you're on-line, or off, Easy Uploads is the Best way to 
insure consistent
Description3=Titles, Keywords, and Descriptions for your files on CIS. Quit busting your 
knuckles typing those descriptions! Shareware - Requires Win 3.1/WinCIM or 
CSNav/VBRUN300.DLL. NOT CRIPPLED

[FORUMS]
Forum0=CSNav Support
Forum1=WinCIM Support

*May be out of date as of this release, however, you get the point.

Copying a Data File
If you wish to Copy an existing data file to use for a new file, simply choose "Save As..." from the File 
menu, to give the file a unique new name.
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 Easy Uploads Help Contents
The Easiest Way to Upload files with WinCIM or CSNav!
(Soon to include America Online!)
Version 2.01

Easy Uploads is Distributed as Shareware.

Feel Free to Evaluate Easy Uploads for 30 Days. If you continue to use Easy Uploads more than 30
Days, you are obligated to Register it, or remove it from your computer. Please feel free to copy this

Shareware program, and pass it along to friends, colleagues, or your favorite BBS.

This Help file was written for the Intermediate-Advanced user. The assumption is that: if you're smart 
enough to Upload files to CompuServe, I don't need to explain Windows or WinCIM/CSNav in great 
detail. It also assumes a general understanding of INI files.

Requirements: Windows 3.1, WinCIM or CSNav, VBRUN300.DLL (not included), MHGMEN.VBX, 
MHRUN400.DLL (both MH*.* files are included), and data files that you create.

The Help Contents lists Help Topics available for Easy Uploads.    Use the scroll bars to see entries not 
currently displayed in a current Help window.
Select an underlined jump word (e.g. "Editing Upload Data Files" below) to move directly to a Topic.

General:

        License Agreement/Warranty

        Version Information

        What is Easy Uploads?

Controls/Menus/Keyboard:

        Control Descriptions

        Menu Descriptions

        Shortcut Keys

Creating Files/Uploading:

        Creating/Editing Upload Data Files

        Notes about your Upload Descriptions

        Spell Checking

        Uploading Files to WinCIM

        Uploading Files to CSNav

        Creating an ATO (AutoSig) Script File

        Using the Demo Dialogs

Additional Easy Uploads Features:

        Defaults

        Save As DIZ

        Forum Tracker



        Time Estimate

        ZIP Contents

        Run Zip Association

        Custom Signatures

        Search Forum Library (CSNav users only)

        VBFile Stamper©

        Easy Uploads Scripting©

Registering Easy Uploads:

        Registration Information

        Registering via SWREG

From the Button Bar at the top of the window (example)

Select the Contents button at any time, to return to this Window. 
Select the Search button, to see a list of Help topics to select.
Select the Back button, to move backwards one step in the current viewing order.
Select the History button, to display a selectable list of all the topics you've viewed.    
Select the << | >> browse buttons, to scroll through the Help file Topics.
Select the Print button at any time, to Print the currently displayed topic.

CompuServe, WinCIM, and CSNav are Copyrights of CompuServe Inc.
Windows, and Notepad are Copyrights of Microsoft Inc.
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 Registration Information
Your registrations allow me to improve Easy Uploads, and write other programs for you to enjoy, at a 
reasonable cost.    The registered version of Easy Uploads will NOT display the Startup Reminder.    In 
addition to sending a check you can also register via SWREG on Compuserve. Registration has many 
other benefits, including: technical support via mail and/or Compuserve, and reduced prices on any of my 
other Shareware programs!    Upon registration, you will receive a registration code, to upgrade your 
Shareware version to a fully Registered version.    To register your copy of Easy Uploads, select the Print 
button above to print this window. 
Enter your information, and send it along with $15.00US (payable to P. Scott Antony) to:

P. Scott Antony
P.O. Box 11047

Shorewood WI, 53211

Easy Uploads Registration Information:

First Name: MI: Last Name:
|__|__|__|__|__|__|__|__|__|__|__|__| |__| |__|__|__|__|__|__|__|__|__|__|__|__|__|__|
Company:
|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|
Address 1:
|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|
Address 2:
|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|
City:
|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|__|
State: Zip: CIS E-Mail #
|__|__| |__|__|__|__|__|-|__|__|__|__| |__|__|__|__|__|,|__|__|__|__|

I downloaded Easy Uploads from the ________________________ Forum, on CIS.

Upon registration, you will receive a registration code, to upgrade your Shareware version to a fully 
registered version.    Just enter the code, and your ready to upload, upload, upload.    If you are a 
Compuserve user, be sure to include your E-Mail address for quicker response.

Registered users can automatically upgrade Easy Uploads by downloading the newest version from Compuserve when it becomes 
available (your registration will be automatically recognized by the new version). 

!!! Thanks for your Support !!!
Scott
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 Uploading Files with WinCIM
Once you've created your data files, using Easy Uploads to upload your files to a forum using WinCIM is 
just that, EASY!    This topic contains a lot of important information. Be sure to read it in its entirety.

IMPORTANT One of the advantages of using Easy Uploads is that you can compose everything OFF-
line.    The following assumes that you've already created, edited, spell checked, etc. your data file(s), and
you're ready to go.    You will negate Easy Uploads' usefulness if you compose ON-line.

Here's how it works:
    1). Open Easy Uploads.
    2). Select the Data File for the Program you want to Upload (everything correct, and ready to go).
    3). Make sure the "On Top" check box is Enabled, and the "Warnings" check is set to your liking.
    4). Minimize Easy Uploads.
    5). Logon to WinCIM.
    6). "GO" to the Forum where the file is to be posted.

$$$ Extended Connect Charges Start Now $$$
    7). Select "Library|Contribute" from the WinCIM menu, or click the Contribute Icon in the toolbar.
                      The Library Contribute dialog box will appear.
    8). Click the Easy Uploads icon once to display the Control menu.
    9). Select the "Send: ?????" item.

If the "Warning" check box is enabled, you will receive the following message.

Translation: Make sure you executed step 7 above, and the cursor is properly set. 
If the cursor is NOT in the proper input box, select Cancel, properly set the cursor, and begin again.

Proper Cursor Position for Send Data
The easiest way to properly set the cursor for Send Data, is to do nothing, after you open the Contribute 
dialog (leaving the cursor in the "File Name" input box).    If you have changed the focus away from the 
"File Name" input box, give it the focus again (click in the box), before you select Send Data.

If everything is OK, select the OK button to start sending data.    Easy Uploads will Minimize itself, and 
send your data to the dialog.    



Since it is impossible to predict what will be in your "Forum" list box (this generally defaults to the proper 
one anyway), I have left this up to you.    A couple clicks of the mouse, no problem. Be sure that you 
properly set all three dropdown list boxes, including the Library, BEFORE you select OK.    They're
set?    Then you're ready, GO GO GO!

Select OK to begin uploading your file. 
$$$ Extended Connect Charges Are Suspended While Uploading $$$*
* most forums do not charge for the actual upload time, only the time spent filling out the dialog.                     
Go get a cup of coffee, and when you get back, if you have other files to upload, Easy Uploads is ready! 
Select "Library|Contribute" from the menu to open the dialog again. Then maximize Easy Uploads, and 
click on the new data file in the list box to get Easy Uploads ready. Click Send Data, and away you go!    
EASY!

You've just digested a lot lot of information, and it may seem from the length of my explanations that the 
process is complicated, but once you try it once or twice, you'll see that it can be done quickly, and easily, 
and in less than 10 seconds!    Once you've got the hang of it, you can turn off the Warnings, and things 
will really fly.    
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 Uploading Files with CSNav
Once you've created your data files, using Easy Uploads to update your Script to Contribute a file using 
CSNav is just that, EASY!    This topic contains a lot of important information. Be sure to read it in its 
entirety.

IMPORTANT One of the advantages of using Easy Uploads, like CSNav, is that you can compose 
everything OFF-line.    However, while CSNav lets you do this, it DOES NOT save the data for your 
Uploaded files in its Script once it's been uploaded.    You must still type in all the data EVERY time you 
want to upload ("Contribute") a file.    

Here's how it works:
    1). Open Easy Uploads.
    2). Select the Data File for the Program you want to Upload (everything correct, and ready to go).
    3). Make sure the "On Top" check box is Enabled, and the "Warning" check is set to your liking.
    4). Minimize Easy Uploads.
    5). Open CSNav, and your Script.
              Example:  

    7). Select Contribute Files... button in the CSNav Script Tree for the proper Forum.
                      The Contribute File dialog box will appear.
    8). Click the Easy Uploads icon once to display the Control menu.
    9). Select the "Send: ?????" item.

If the "Warning" check box is enabled, you will receive the following message.



Translation: Make sure you executed step 7 above, and the cursor is properly set. 
If the cursor is NOT in the proper input box, select Cancel, properly set the cursor, and begin again.

Proper Cursor Position for Send Data
The easiest way to properly set the cursor for Send Data, is to do nothing, after you open the Contribute 
dialog (leaving the cursor in the "File Name" input box).    If you have changed the focus away from the 
"File Name" input box, give it the focus again (click in the box), before you select Send Data.

If everything is OK, select the OK button to start sending data.    Easy Uploads will Minimize itself, and 
send your data to the dialog.    

Be sure that you properly set both dropdown list boxes, including the Library, BEFORE you select
OK.    They're set?    Then select OK.

If you have other files to upload, Easy Uploads is ready! Open the "Contribute" dialog again. Then 
maximize Easy Uploads, and click on the new data file in the list box to get Easy Uploads ready. Click 
Send Data, and away you go!    EASY!

You've just digested a lot lot of information, and it may seem from the length of my explanations that the 
process is complicated, but once you try it once or twice, you'll see that it can be done quickly, and easily, 
and in less than 10 seconds!    Once you've got the hang of it, you can turn off the Warning, and things will
really fly.    
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Notes about Descriptions
As much as Easy Uploads states that it helps to insure consistent data across multiple forums, I cannot 
guarantee that this will be the case.    So, I feel I need to make a simple (and somewhat obvious) 
disclaimer, and explain.

DISCLAIMER: While I can guarantee that Easy Uploads will consistently fill the 'Contribute' dialog with 
your data, I cannot guarantee that the data displayed on CompuServe will be consistent with what you 
uploaded.    The SysOp of the forum, ultimately, has the final word about how the information for your file 
is displayed.    Even I am not immune to this "problem", as you'll see later.

NOTE: Any SysOp or User reading this, who would like to add anything, or refute anything I'm about to 
state, can feel free to write me with your observations. If of use to the general public, I will be happy to 
include them in the next version's Help file, so these types of things happen less often. 

I'll Explain: 
Many CompuServe forums/libraries have their own conventions for displaying the information regarding 
user contributed files.    In general, your: Destination Name, and Keywords are pretty safe as is, however 
your Title and Description are areas where you may see a variety of different things happen.    A few 
things to watch...

Your Title: 
Be sure to include a version number for your program somewhere in either the Title, or the Description.    
Most forums seem to prefer that it appear in the Title.    
If you don't include a version number, some may use its Date, (v10-31-94) which looks pretty silly 
(I should know, as one did it to my first version of Easy Uploads which didn't have ANY version number!    
My fault!    I should have known better.)
Don't get too crazy with the Title.    Although you can type a lot in the box, the number of characters visible
to users while doing a quick scan of files is limited.
Don't use ALL CAPS for your Title (reduces the number of characters visible, and really annoying).

Your Description:
Some forums will automatically add your name, some will add comments regarding their forum, while 
others will include your SWREG#, and a host of other little idiosyncrasies.    Sometimes even additional 
spaces show up, or punctuation is missing (how that happens is a mystery to me, unless someone is 
retyping it? Maybe they should get Easy Uploads?). 
Always include your SWREG# for your program if it's registered with the service.
Include the version number for your program, if not already in the Title.

In general, you should be checking up on your file after it's been posted.    Check all the parts carefully to 
be sure they're OK.    Easy Uploads is a good way to check, since it can stay On Top of CIM, as you view 
the data that's been posted. 

Authors Note: In over 100 Uploads of my own Shareware/Freeware to CIS, I've only found about 30 
occasions where my original Description has been left completely intact, without modification.    

In the majority of instances where it had been altered, it was never anything glaring, or detrimental, and a 
few even helped, so I simply left them, and had fun waiting to see what they came up with the next time. 
In a few instances I felt I needed to contact the SysOp, and request some changes.    In ALL such 
instances I was given a fair shake, and was able to compromise with the SysOp.    

So please, if a SysOp changes your description to the point you think is unreasonable, or incorrect, don't 
start your E-mail off with: "What the h-ll have you done to my description?".    Something like: "In reviewing
my recent upload to your forum, I noticed that the description for my program is in error.    ......could you 



please change it to: ...." will inevitably get you better service.    Also, be sure to include how you want the 
description to read, including any of the things they may have added, like your SWREG#    (don't just send
back your original description, as it obviously didn't meet their criteria the first time).    Also, they will be 
more eager to help if they have the new data with the first E-mail you send, and don't have to chase you 
down, and play E-mail tag.
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Menu Descriptions
      File Menu
                                                      Shortcut Keys  
            New... Ctrl+N
            Open... Ctrl+O
            Save As... Ctrl+A

Select a Source file, and then choose Save As... to make a copy of the Source file.
Enter a new name for the file in the Save As dialog, and select OK.

            Save As DIZ... Ctrl+V
            Delete... Ctrl+D

Select this menu item (or press <Ctrl>+D) to delete the currently selected file.
You will be given one opportunity to change your mind.

            Backup... Ctrl+B
Select this menu item (or press <Ctrl>+B) to create a backup of the currently selected 
file. You will be given one opportunity to change your mind.

            Print    Ctrl+P
Print the current Data file.

If you want to Print more than one file at a time, you can select multiple files in the list by 
holding the Control key, and clicking with the mouse (at present, multiple selection in the 
File list only applies to the time estimate, and printing).

            Print ZIP Ctrl+Z
Print the contents of the ZIP source file (same as what you see in the ZIP Viewer list). 

            Print Instructions Ctrl+I
Print Quick Instructions for WinCIM users. This is a quick print of the steps required to 
upload a file (in case you're online, and need a hand). CSNav users are already offline, 
and can refer to the Uploading Files to CSNav topic in this help file if you get stuck.

            VBFile Stamper... Ctrl+T
            Exit Ctrl+X

      Edit Menu

            Undo Ctrl+Z
            Copy Ctrl+C
            Paste Ctrl+V

All three are standard Windows behavior.
NOTE: The Edit menu is only available when the cursor is in one of the input boxes.

      Options Menu

            Defaults... F3
            Forum Tracker... F4
            WinCIM Demo Dialog...
            Launch WinCIM

Start WinCIM.    NOTE: You must have properly specified the PATH to WinCIM for this
feature to work properly. See Easy Uploads Defaults.

            CSNav Demo Dialog...
            Launch CSNav

Start CSNav.    NOTE: You must have properly specified the PATH to CSNav for this
feature to work properly. See Easy Uploads Defaults.

            Custom Signatures...



      Upload Menu

           Send Data F5
            ZIP Contents... F6
            Run ZIP Association... F7
            Spell Check Excel... F8
            Spell Check Word... F9
            Time Estimate... F11
            EU Scripting... F12
            ATO Script File... Ctrl+F5
            CIS Copyright Notice...

      Search Forum Menu

            Define Search... Ctrl+F
            Send Search Ctrl+F12

      Help Menu

            Contents F1
Open the Help file to the Contents topic.

            Search... F2
Search the Help file before opening it.

            Registration Information
            Enter Registration Code...

After you've received your registration code, select this menu item, 
and enter the code when prompted.    Thanks for your Support!

            About...
Display the About box (the only place you'll find the current EU version number)
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Data Files
The Data Files list box displays all the data files in your Easy Uploads directory. Simply click on a file 
name to display its data, or move up/down the list with the arrow keys. Double-click on a file to edit it with 
Windows Notepad.
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New
The New button/menu item helps you begin a data file.    You will be prompted for a name to give the new 
data file.    Use standard filename conventions, and enter a name up to 8 characters.    You do not need to 
add a file extension, as .INI will be applied automatically by Easy Uploads.    After you name the file, Easy 
Uploads will prompt you for the Source File that you want to Upload.

Easy Uploads is a Copyright of P. Scott Antony, 1995.



Open
The Open... menu item opens the currently selected data file.    Easy Uploads will open it in Windows 
Notepad so you can edit your data.    You can also use the <Ctrl>+O shortcut key combination to edit the 
currently selected file.

NOTE: For Users of Version 1.02 and Before.
You no longer need to use Notepad to edit your files. You can now do all your editing within Easy 
Uploads.    This feature has been retained for those of you who might prefer it. Also, you can still double 
click in the File list to open your data file in Notepad.
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Menus
Many of the buttons have equivalents in the Easy Uploads menu, however, some features can only be 
accessed from the menu.    File Delete... is a prime example. See Menu Descriptions for more about the 
menus.
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Control Descriptions
Use the mouse to click on different areas of the dialog where the cursor becomes a hand.

If your selection "jumps" you to another topic, select the "Back" button to return here.
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Test File Name
The Test File Name check box allows you to have Easy Uploads check to be sure that the file you've 
specified to Upload actually exists!    If EU cannot find the file when the check box is enabled, you will be 
prompted to that effect.    When disabled, EU will do no checking!

HINT: If you don't have a file already named for your upload, leave the FileName= parameter empty, and 
EU will NOT annoy you by prompting that it doesn't exist.    Be sure to fill it in later!
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Send Data
The Send Data button/menu item starts Easy Uploads on its way.    See: Uploading Files to WinCIM, and 
Uploading Files to CSNav for more on what happens when you press Send Data button.

NOTE: If the Contribute dialog for the currently selected program (WinCIM/CSNav) is not available when 
you select Send Data, you will be notified as such, and offered a Demo dialog instead.    Select No to 
return to EU, or Yes, and EU will display a Demo of the appropriate dialog, and Send your data to it.    This
is a good way to practice with, and without the Warnings.

If you have a Contribute dialog open, and expected EU to work, select No, and check to be sure that the 
WinCIM/CSNav option buttons are set for the proper program, then try again.
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Warnings/On Top
Warnings check box
The Warnings are only to alert you to be sure the cursor is properly placed in the Contribute dialog, and to
set the Forum, and File Type before you press OK.    Once you have the hang of it you can disable the 
Warnings, and things will really fly!

On Top check box
Use this check box to control Easy Uploads behavior.    When enabled, Easy Uploads will float "On Top" of
WinCIM/CSNav when Minimized and Maximized.
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Exit
The Exit button/menu item is a quick way to Exit Easy Uploads.
NOTE: Easy Uploads will never prompt you "If you're Sure?", since there isn't anything to save.
It will simply go away quietly.

Easy Uploads is a Copyright of P. Scott Antony, 1995.



Test Max Chrs.
The standard "Contribute" dialog in WinCIM/CSNav allows approximately 550 characters.    When the Test
Max Chrs. check box is enabled, Easy Uploads will test to be sure you haven't exceeded the limit.    If you 
do, and the check box is enabled, you will be prompted to reduce your description.    Check the bottom 
right corner of the window (Avail. Chrs) to see how many characters you need to trim.

NOTE: If you choose to disable this check box, and exceed the limit, be sure to thoroughly check your 
Description after EU has sent the data.    Most likely, it will have been truncated, and you will have heard a
lot of BEEPS, as EU tries to follow your wishes, only to be denied by the limit.
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Date, Time, and Size
If Easy Uploads is able to find the file you've specified, it will display the last Date/Time it was Saved, 
along with its Size in Bytes.    
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WinCIM/CSNav/AOL Options
The WinCIM/CSNav/AOL option buttons allow you to specify which application you would like your data 
sent to.    Since the Contribute dialogs differ between applications, Easy Uploads needs to know where it's
going, BEFORE you click a Send button.    

NOTE: Easy Uploads is currently under construction to include America Online as a new option.    
Stay tuned for further updates.

Double-clicking the options buttons will Launch the selected program if you have properly set the Path to 
the program in the Defaults dialog.
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Description Statistics
The standard "Contribute" dialog in WinCIM/CSNav allows approximately 550 characters.    These 
numbers provide a measure of how "full" your Description is, displaying the Description Total, and the 
Number of Characters Remaining/Over.
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Data Boxes
The text boxes for: Destination, Title, Keys, and Description, display the information in your Data files in a 
fashion similar to CIS, and the Contribute Dialog.    Edit your data directly in these text boxes.

You can use Ctrl+C/Ctrl+V/Ctrl+Z to Copy/Paste/Undo within the text boxes, or use the Edit menu.
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Library
Since there are way too may libraries for it to be practical for EU to display them, by default, I have filled 
the list with generic library names.    In keeping with CIS's 24 library limit, they are appropriately named:

[0] Library 1
[1] Library 2
etc.

The number in braces designates the "offset" (.ListIndex for you programmers) in the Library list. Don't be 
fooled by what the forum says when it comes to the Library offset.    Often times their numbers have no 
correlation to the offset in the list. A Library might have a list like:

Actual Offset
[1] General 0
[2] Windows 1
[4] DOS 2
[5] OS/2 3
[7] Unix 4

HINT: count the # of {DN} key presses it takes to highlight the proper library in WinCIM or CSNav. (0-
23=Libraries 1-24) then use that number in the list.

You may change the entries by editing them directly in the list box.    Simply type over the default entry.    
To have your change take effect, you MUST press ENTER.    To cancel any changes., select another list 
item.    Any items not changed by you will revert to the default.

To avoid typing in the same Library names for multiple EU data files, do the following:

1). Enter the libraries to ONE of your Easy Uploads data files.
2). Double-click on the data file in the File list to open it in Notepad.
3). Towards the bottom of the file you'll find a section named [Libraries].
4). Select the ENTIRE section, (including the section header: [Libraries]) and copy it to the Clipboard.
5). Close the data file, and return to Easy Uploads.

6). Double-click the next data file in the list that has the same libraries.
7). Press Ctrl+END to select the end of the data file.
8). PASTE the copied libraries to the file.
9). Save, and Close the data file.
10). Repeat from step #6 for each file with the same libraries.
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Using the Demo Dialogs
A companion program to Easy Uploads will display a Demo of the "Contribute" dialogs from WinCIM, and 
CSNav.    You can bring up the Demo dialog from the Options menu in Easy Uploads.    Select the dialog 
that's appropriate for the application you've specified to Send to (not too hard, since the other menu item 
will be disabled).    

Once the demo is displayed, select the Send Data button to test how Easy Uploads will work with 
WinCIM, or CSNav once their dialog is open.    After you've seen the demo, select either the OK or Cancel
button to remove the demo, and return to Easy Uploads (both buttons have the same meaning).    

NOTE: Easy Uploads will automatically give you the option of Sending to the Demo, if the Contribute 
dialog for the appropriate program is not available.    Just click Send Data, and then Yes, to the option, 
and EU will open and send to the demo.

NOTE: The Companion program is named CONTRIB.EXE, and must be in the same directory as Easy 
Uploads to perform properly.    I made this its own program to try and keep Easy Uploads small. Sorry for 
the extra clutter on your hard drive!    CONTRIB.EXE cannot be run from an icon, or from File Manager.    
Only Easy Uploads can open CONTRIB.
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Data File Type
The File Type list box allows you to specify which types of files are displayed in the File list.
The choices are:

Data (*.ini) All Easy Uploads Data Files.
Backup (*.eub) Data files backed up with the Backup button.
Both (*.ini;*.eub) Data and Backup Files.
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Backup
Easy Uploads creates Backups of your Data Files in your Easy Uploads directory, with the 
extension .EUB.
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ZIP Source Contents
Press F6, select the ZIP button, or the Upload|Display Zip Contents... menu item to display the ZIP 
Viewer, and the contents of the Source ZIP archive.    Easy Uploads reads the header data from your ZIP, 
so it never has to call PKUNZIP to find out what's in the archive.

Select the Run ZIP Association button on the ZIP Viewer, to pass the File Name of the current Source 
file to the program Associated with .ZIP in File Manager. See Run ZIP Association.

The ZIP Viewer Dialog is not available when the Source File is anything other that *.ZIP.

NOTE: The contents of the dialog shown above is for display only, and may/may not reflect the files 
currently included with Easy Uploads.

Credit to Paul Bonner is due, for the code used to read the ZIP header.    The nuts and bolts of the code 
was included as a part of his book/disk: Visual Basic Utilities, published by ZIFF Davis Printing/PC 
Magazine.    I made a few changes to one of the dialogs, removed the full ZIP/UNZIP features, adapted it 
for my code, and it worked!    Thanks Paul.    I would have kept the ZIP/UNZIP features, but with so many 
good ZIP shells in Shareware, I didn't want to spend my time recreating the wheel (the code wasn't 
optimized for 2.04g's extra features, since it was published in '93, although the header remains the same).
So instead, I added the Run ZIP Association feature, so EU can give you access to the functions of those 
really good "zip shells".
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Forums
Select the Forums button/menu item to display the Forum Tracker dialog.    See Forum Tracker.
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Source File Name
Easy Uploads will display a standard Open dialog for you to use to specify the Source File that you want 
to Upload to CIS, just like the one in the Contribute dialog.

The Destination Name will be determined from the Source, and entered automatically.

NOTE: If Easy Uploads finds a file named: FILE_ID.DIZ (DIZ - Description in ZIP) in your Source 
directory, it will prompt you whether you want to read it in to the Description to give you a quick head start.
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Forum Tracker
Press F4, select the Forums button, or the Options|Forum Tracker... menu item to display the Forum 
Tracker.    After you Upload your file, be sure to add the Forum to its List!    Forum Tracker makes it Easy 
to remember where to post your Upgrades!

Last Uploaded is a field where you can enter the date you last uploaded the file. 

Add a Forum from the Master list (left) to your Upload List by: 
Selecting a Forum and pressing Enter.
Selecting a Forum and pressing the Add -> button.
Double clicking on a Forum.

Once you've added a forum to your upload list, specify a Library for the Forum by entering the Library 
name in the text box.    If you care to keep track, you can also enter the number of Accesses your upload 
has received.

NOTE: Pressing ENTER in the Accesses box automatically selects the next forum in your upload list, and 
highlights the current accesses to get ready to overwrite them.    This makes it easy to run down the list 
with Num Lock, the Ten Key pad, and the Enter key.    If the Accesses haven't changed, simply Press 
ENTER to go on to the next forum.

NOTE: The Library and Accesses entries are optional.    

Remove a Forum from your Upload list (right) by: 
Selecting a Forum and pressing Enter.
Selecting a Forum and pressing the <- Remove button.
Double clicking on a Forum.

To Add a New Forum to the Master list (left).



Select the New Forum button.
Enter some text to describe the Forum.
This can be anything that makes sense to you, since it won't be used in your Upload.
Select OK.

The Forums for this Upload data is written to your Easy Uploads data file when you press the Save 
button.    Press Cancel to abandon any changes.

NOTE: Adding New Forums to the Master list (left) is independent of the Upload list in terms of the Save 
button.    New forums added to the Master list are saved immediately, and remain even if you select to 
Cancel changes to your Upload list.

NOTE: Currently there is a limit of 200 forums in the Master list. If anyone out there needs more, please 
contact me.
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Warranty Disclaimer
Copyright/License/Warranty
Easy Uploads Copyright © 1994 by P. Scott Antony.
All rights reserved.
Contact me at: 74002.2373@CompuServe.com
or P.O. Box 11047

Shorewood, WI    53211

License Agreement
You should carefully read the following terms and conditions before using this software.    

Shareware Version
Evaluation and Registration
Easy Uploads is distributed as Shareware. Shareware is a form of software distribution, not free software. 
You are hereby licensed to use this software for evaluation purposes without charge for a period of 30 
days.    If you use this software after the 30 day evaluation period a registration fee of $15 is required.    
Payments must be in US dollars drawn on a US bank, and should be sent to P. Scott Antony, P.O.    Box 
11047, Shorewood, WI    53211. 
See: Registration Information.

Unregistered use of Easy Uploads after the 30-day evaluation period is in violation of U.S. and 
international copyright laws.

When payment is received you will be sent a registration code to upgrade to the Registered Version.    
There are significant advantages to registering your copy, not least the continued availability of good 
quality software at reasonable prices.    Registrations allow me to improve the program, and create more.   
Keeping the Shareware concept alive benefits you with access to thousands of inexpensive try-before-
you-buy programs.    

Please note that "buying" this program from a Shareware distributor does not count towards registering it! 
I do not receive any money from Shareware distributors. My only payment comes when you register 
directly with me.    

Distribution
Provided that you verify that you are distributing the Shareware Version (select About from the Easy 
Uploads Help menu to check) you are hereby licensed to make as many copies of the Shareware version 
of this software and documentation as you wish; give exact copies of the original Shareware version to 
anyone; and distribute the Shareware version of the software and documentation in its unmodified form 
via electronic means.

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission, with one exception:    Disk Vendors approved by the 
Association of Shareware Professionals are permitted to redistribute Easy Uploads, subject to the 
conditions in this license, without specific written permission.

Registered Version
One registered copy of Easy Uploads may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used non simultaneously by 
multiple people, but not both.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.



Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.    Because of the various hardware and software 
environments into which Easy Uploads may be put, NO WARRANTY OF FITNESS FOR A 
PARTICULAR PURPOSE IS OFFERED.    Good data processing procedure dictates that any 
program be thoroughly tested with noncritical data before relying on it.    The user must assume 
the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED 
EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.
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Shortcut Keys
You can use any of the following key combinations to access Easy Uploads functions.

When the Easy Uploads Window is Active...
             Function Keys                           Function  

F1 Help Contents
F2 Search Help File
F3 Defaults
F4 Display Forum Tracker
F5 Send ALL
F6 Display ZIP Contents
F7 Run ZIP Association
F8 Spell Check Excel
F9 Spell Check Word
F11 Time Estimate
F12 EU Scripting

             ALT+Key Combination              Function  
ALT+A Send ALL
ALT+B Backup
ALT+C Select CSNav as the Destination program
ALT+D Make the Description box active
ALT+I Make the Destination box active
ALT+K Make the Keys box active
ALT+L Make the Library list box active
ALT+M Select WinCIM as the Destination program
ALT+N Select Source File Name
ALT+P On Top check box
ALT+R Display Forum Tracker
ALT+S Make the Easy Uploads Data Files list box active
ALT+T Make the Title box active
ALT+W Warnings check box
ALT+X Exit
ALT+Y Select File Type
ALT+Z Display ZIP Contents

             Ctrl+Key Combination              Function  
Ctrl+N New File
Ctrl+O Open File
Ctrl+A Save As...
Ctrl+S Save As DIZ...
Ctrl+D Delete File
Ctrl+B Backup File
Ctrl+P Print File
Ctrl+Z Print ZIP
Ctrl+I Print Instructions
Ctrl+T VBFile Stamper©
Ctrl+F Define Forum Search (CSNav Only)
Ctrl+F5 ATO Script File
Ctrl+F12 Send Search (CSNav Only)

When the Forum Tracker Window is Active...
             ALT+Key Combination              Function  

ALT+A Select the Add -> button



ALT+C Cancel any Changes, and close the Forum Tracker
ALT+E Make the Accesses box active
ALT+F Make the Forums for this Upload Title list box active
ALT+L Make the Library box active
ALT+N Select the New Forum button
ALT+O Make the Forums list box active
ALT+R Select the <- Remove button
ALT+S Save the Current Settings, and close the Forum Tracker

When the ZIP Viewer Window is Active...
             ALT+Key Combination              Function  

Enter Done
ALT+O Done
ALT+N Make the ZIP list box active
ALT+R Run ZIP Association
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Registering via SWREG
As well as mailing a check/money order, you can also Register Easy Uploads via the CompuServe 
SWREG Service.    

However, note that since CompuServe gets 15% of all programs registered on SWREG,the Registration 
fee for Easy Uploads on SWREG is $17.50.    (I guess Shareware means even CompuServe get its 
"share" too).    I'm sorry, but at only $15, I can't afford to eat the 15% myself.    

To Register Easy Uploads via SWREG:
Log-on to CompuServe
Then "GO" to "SWREG" (GO SWREG)
Give Easy Uploads Registration ID# when requested: 4046
Follow the remaining instructions on-screen.

I will E-mail you your Easy Uploads Registration Code, as soon as SWREG notifies me of your order.
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 Easy Uploads Version Information
You are reading this topic for one of three reasons: 1). you chose to, from the Contents topic, or 2). it has 
come up automatically because you're a New User, or 3). you've just upgraded Easy Uploads.    
Easy Uploads will display this topic each time you upgrade the software, to tell you what's new!    

The date shown with each Version indicates the dates of the EXE/HLP files included with that version.    
The time of EXE/HLP files indicates the version number, such that for version 1.09, the EXE/HLP files are
time/date stamped as: EASYUP.EXE    4/20/95    1:09am.

New features are only described once.    If you're new to Easy Uploads, please read the complete topic for
better understanding of all of the features.

 NEW! Easy Uploads Scripting for WinCIM, is almost here!

In recent weeks I've created an "auto-pilot" of sorts, for EU and WinCIM, and it's now in BETA with 
a few users who will take a shot at it!    Many Thanks to the BETA testers!
EU Scripting will be ALL point and click, with a listing of over 750 Forums (and their respective 
Libraries) to choose from! Simply select a Forum to GO to, an EU data file to use for the Upload, 
and the Library to post to, and you're all set! Select multiple files for a Forum, or select multiple 
Forums. Hopefully, the file you're reading now was uploaded with EU Scripting, since I'm taking 
the opportunity of EU v2.01, to be its first run with real uploads. The upload script will contain 
over 20 forums, and over 30 files, so wish me luck!

NOTE: Easy Uploads Scripting will be FREE to Registered Users!    Unregistered Shareware users
will be limited to 2 Forums per Script, with 3 Uploads per Forum (=6 uploads per script).    *You can

add as many Forums and Files as you like, but it will only upload as described above.    The
theoretical limit for Registered Users is over 1,500 uploads per Script!

Look for Easy Uploads Scripting in the coming weeks...
For now, take a look at what I've done for the newest version of Easy Uploads...

Version 2.01        6/20/95    (Current Version - *** Upgraders and New Users - Please Read ***)  

NEW Added buttons to paste a Custom Signature, and Time Estimates to your Description.
Define your signatures, and then with a click, Easy Uploads will paste them to any 
position in your Descriptions. Most users will appreciate knowing how long your download 
will take, and you can include any/all of the 5 baud rates from the EU time estimate!

NEW Added a Custom Signatures... item to the Options menu.
Select this menu item to Define your Signatures for the buttons described above.

NEW Added a new Hard Return symbol for the Description.
The Description box still doesn't accept hard returns, although now you can compensate 
for that by entering a special "linefeed" symbol, and EU will add the hard returns in the 
Contribute dialog. Periods enclosed in BRACES [] will now add hard returns. Add a period 
for each linefeed required (as in [...] for three, or [.] for just one). 
Select the LINEFEED.INI data file (included) from Easy Uploads for more info, 
and then Send it to the Demo Dialog to see how it works!

NEW Added a ATO Script File... item to the Upload menu (or Ctrl+F5).
Easy Uploads can now create an Upload Script File for users of ATO (AutoSig).
You can select multiple EU Data Files, and EU will create a multiple upload script.

NEW Added a new Print button to the main form.
Print your data file with a simple click of the mouse (File|Print, and Ctrl+P still work).

Maintenance:



Moved the Warning, and On Top checkboxes to the Deafults dialog.
All buttons have been moved to the bottom of the main form, and the text replaced with icons.

Version 2.00        5/20/95  

NEW Added a VBFile Stamper© menu item to the File menu.
I've created a Freeware utility to Date and Time Stamp files in Windows.
Date/Time stamping is useful as "fake" version control for your files.
If you've downloaded "Easy Uploads Pro", then you already have VBFile Stamper.
If not, and you want it, you'll have to download it separately. See: VBFile Stamper

NEW Added a Search Forum Library dialog for CSNav users.
Just as Easy Uploads makes it easier to send Contribute data multiple times, it now 
makes it easier to send Search criteria to multiple Forum Search Dialogs.

NEW Added the ability to use the Time Estimate dialog for Downloads as well as Uploads.
NEW Added the Estimated $Cost of Downloads to the Time Estimate dialog.
NEW Added a Disable Screen Saver While Open option to the Defaults dialog.

Easy Uploads can now disable your screen saver while it's open, to avoid problems 
if the saver kicks in during uploading, or downloading.

NEW Added a WinCIM Library/Contribute Dialog Title option to the Defaults dialog.
Users of the German and French versions of WinCIM will need to change this option so 
Easy Uploads can work properly with their software.    ALL users of the English version of 
WinCIM should essentially work under the assumtion that this option does not exist, and 
should not change the default entry!

Maintenance:
Updated the 'Send Data' code to work with the new CSNav 1.1.1.    
Updated all forms to the new Win95 look.

Version 1.09        4/20/95  

NEW Added a Time Estimate Dialog, and Time Estimate... item to the Upload menu.
Easy Uploads will ESTIMATE the time required to upload your files to CIS (based on the 
file size).    Estimates are given for 2400, 9600, 14400, 19200, and 28800 Baud.

NEW Added a Status Bar.
Simply move the mousepointer over any area of Easy Uploads, and the Status Bar will 
display helpful information related to the object under the mousepointer.

NEW Added a Show Status Bar option to the Defaults Dialog.
You have the option of displaying the status bar, or not.

NEW Added a Start Minimized option to the Defaults Dialog.
Enabling this option will start Easy Uploads as an icon (minimized).

NEW Added a new Destination option button for America Online© (currently disabled).
For the time being this option is disabled. However, I've included it in advance to let you 
know that it's currently under construction, and will be enabled in a future version.

NEW Added a DIZ button to the main form.
This button is equivalent to selecting Save As DIZ... in the File menu.

NEW Added a CIS Copyright Notice... item to the Upload menu.
With the Advent of WinCIM 1.4, CIS will now display a Copyright Notice you must "Agree" 
to in order to upload your file.    This option displays the text of the new notice.

Maintenance:
Improved this Help File:    Added more information about DIZ files (please read), and describe a shortcut 
for copying your edited Libraries to multiple data files.

Version 1.08        4/4/95  

NEW Added Save As DIZ... to the File Menu (or use Ctrl+S).
Easy Uploads will now create a DIZ file (Description in ZIP) from your EU description.

NEW Support for CIS's new 8.3 filenaming convention.



Easy Uploads will no longer warn you that your filename exceeds the old 6 character 
limit, since CIS now allows 8 character names. NOTE: According to CIS, WinCIM users 
can begin using the new names now.    However, CSNav users cannot use 8 character 
names until the software is updated (see the CSNav Support forum for more info).

NEW Added the file list count to the text directly above the file list.
Maintenance:
None.

Version 1.07        3/21/95  

NEW Added a Spell Checking button/menu item for MS Word (in addition to Excel 5x).
If you're an MS Word user, Easy Uploads can utilize its spell checker via OLE to 
Spell Check your Descriptions. Sorry, if you don't own MS Word, you must still copy
your descriptions to another application to spell check.
If EU doesn't find Word on your system, the options will be disabled.

NEW For those of you who don't have Word or Excel see the Spell Checking topic anyway for 
an alternative I've recently discovered.    Even if you never use Easy Uploads again, or 
already own Word and Excel, you'll want to see this program...

NEW The Library list box is now Fully Editable.
The contents of the Library list is also unique to each upload file!    Enter different libraries
for different uploads.    However, I should note that there is only one list per file, so unless 
you only upload your file(s) to a single forum, you should probably not change the library 
entries, as no two forums have the same name for Library 0, 1, 2, etc.    

Maintenance:
Changed the Send ALL item in the Control Menu (when EU is minimized) to reflect the Destination 
filename you're uploading.    So, if the destination filename for your upload is MYFILE.ZIP, the menu item 
will read: Send:    MYFILE.ZIP.    As you change upload selections, the control menu will change 
accordingly.    You can see that this has meant changing the accelerator key from A to S since it should 
remain consistent, and not change with the current filename.    So, once the menu is displayed, you can 
simply press S instead of clicking the item.

Version 1.06        1/29/95  

NEW Added Spell Checking to the Options Menu (or use F8).
NEW Added a Spell Checking button.

If you're an MS Excel 5.x user, Easy Uploads can utilize its spell checker via OLE to 
Spell Check your Descriptions. Sorry, if you don't own MS Excel, you must still copy
your descriptions to your wordprocessor to spell check.
If EU doesn't find Excel on your system, the options will be disabled.

NEW Added File Type Selection List.    
Select from: Binary, Text, GIF, JPEG, RLE* (*CSNav only)

NEW Added Run ZIP Association to the Upload Menu (or use F7).
NEW Added a Run ZIP Association button to the ZIP Viewer Dialog.

You can now invoke the application that's Associated with "ZIP" in File Manager.
EU will start the Associated program, and pass the current ZIP File Name.
These options, therefore, are equivalent to double-clicking on a ZIP file, in File Manager.
This is especially useful if you use a utility like WinZIP© to maintain your Upload Archives.
© WinZIP is a Copyright of Niko Mak Computing, Inc., and is not affiliated with Easy Uploads in any way.
(other than the fact that I've Registered it, and find it a very useful utility :-)

NEW Added Last Uploaded entry to Forum Tracker, so you can note the last date the file was uploaded.    
NEW Added "Last Uploaded" to the data file Printout.
NEW Added Common Upload Directory to the Defaults dialog.

If you keep all your upload files in one directory, you can set the File Name dialog to start 
by listing the files in the "Common Directory".    Simply enable the check box in the 
Defaults dialog, and enter your path.

Maintenance:



Changed the wording in the Warnings and Alert Dialogs to be more specific.
Moved the date and time printed, to the bottom of both printouts.
Moved the ZIP and Forum Buttons to the upper left corner to make room for the File Type List.

Version 1.05        1/10/95  

NEW Added Send ALL to the System Menu (Control Box/Minimized Menu).
You can now send your data without Maximizing EU to get at the Send ALL button.
When minimized, simply click the EU icon once to display the system menu, and 
then select Send ALL.

NEW EU will "remember" the last data file you worked on, and select it to start future sessions.
Maintenance:
Fixed the problem of Easy Uploads not properly displaying the Paths to WinCIM, and CSNav in the 
Defaults dialog for the Launch Feature.    Although it always worked properly, if you changed the default 
path, EU did not update the dialog box properly.

Version 1.04        12/19/94  

NEW Added Library to Forum Tracker.    Specify which library you uploaded your file to.
NEW Added Accesses to Forum Tracker. Track how many have downloaded your upload.
NEW Added Library/Accesses to the data file Printout (with Total: Forums/Accesses).
NEW Added a ZIP Contents Printout (when a ZIP Source).
NEW Launch WinCIM or CSNav from Easy Uploads.

Added two menu items under Options to perform Launches, or you
can double-click either Option Button to Launch the selected program.

NEW Added Defaults... to the Options menu. Currently, the Defaults dialog only contains
input boxes for you to specify the Paths to WinCIM and CSNav for the Launch feature.
As I improve EU even more, I'm sure there will be other Defaults to set in the future.

Maintenance:
Fixed the problem of Easy Uploads not sending special characters to the Contribute Dialog.
Specifically, it was omitting: % ^ + ( ) { } [ ].    These characters will now be sent.

Version 1.03        12/6/94  

Easy Uploads now lets you edit directly in the dialog.    No more need for Notepad!
You can still use Notepad if you prefer, just double click the filename as before.
NEW Forum Tracker

Forum Tracker Help you Remember where you Uploaded your files.
NEW ZIP Viewer

View the contents of your Source File Name (ZIP only).
 NEW Specify Source File Name with Standard Windows Open dialog.

Easy Uploads will also set the Destination Name, based on the Source.
It will also test for CIS's 6 character limit, and truncate the name like CIS does.
(You'll receive a message if it changes the Destination Name).

NEW Added Edit to the Menu.
Standard Undo, Copy, and Paste, for use in the input boxes.

NEW Added Backup button to create EUB (Easy Uploads Backup) Files.
NEW Added File Type list to specify which Types of files to display in the File list.
Updated the Help file to include new features.

Version 1.02        12/2/94  

NEW Now works with CompuServe Navigator in addition to WinCIM.
NEW Added Demo Contribute dialogs, so you can practice Sending your data.
NEW Added Library list box to set Forum Library.
NEW Added Test File Name/Test Max Chrs. check boxes to enable/disable tests, and alerts.



NEW Added display of the Date/Time/Size of the Source File Name.
Moved Delete to the File menu (used to be a button).
Updated the Help file to include new features.

Version 1.01        11/10/94  

Save Time/$ Uploading Files to CIS. Now works with WinCIM AND CSNav, and includes "Forum Tracker",
and "ZIP Viewer"!    Easy Uploads allows you to specify data for your programs in a text file, and then you 
can fill the "Contribute" dialog in WinCIM/CSNav in seconds, time after time!    Whether you're on-line, or 
off, EU is the best way to help insure consistent Titles, Keywords, and Descriptions for your files on CIS.    
Shareware - Requires Win 3.1/WinCIM or CSNav/VBRUN300.DLL.    SWREG #4046.    Uploaded by 
Author.

CompuServe, WinCIM, CSNav, and Navigator are Copyrights of CompuServe Inc.
Word, and Excel are Copyrights of Microsoft Inc.
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Defaults
Press F3, or select the Options|Defaults... menu item to display the Defaults dialog.

The Defaults dialog contains input boxes for you to specify the Paths to WinCIM and CSNav for the 
Launch feature, a Path to a Common Upload Directory for the File Name button, and other miscellaneous 
options.    

Launch Paths
Select the appropriate Browse button to specify the FULL Path to WinCIM and CSNav.    
Easy Uploads comes set for the default directories in the respective Setup programs. Specifically:

C:\CSERVE\WINCIM\WINCIM.EXE
C:\CSERVE\CSNAV\CSNAV.EXE

If you changed these directories when you installed either of these programs, then you will need to make 
the corresponding changes in the Easy Uploads Defaults dialog.    Otherwise, you should be all set.

Once properly set, you can Launch a program by selecting it from the Options menu, or double-clicking 
on the appropriate option button.

Common Upload Directory Check box, and Path
Select the appropriate Browse button to specify the FULL Path to your Common Upload Directory.
If you keep all your upload files in one directory, you can set the File Name dialog to start by listing the 
files in the "Common Upload Directory".    Simply enable the check box, and select your path.
If you've created a subdirectory to EASYUP for your upload files, and named it UPLOADS, then you'd 
select C:\EASYUP\UPLOADS as your common upload directory.

When the Use Common Upload Directory check box is Disabled, (or if you enter an invalid Path) the 
File Name dialog will start by listing the files in your Easy Uploads Directory.

WinCIM Language, and Contribute Dialog Title
Users of the English version of WinCIM should NOT change this option from "English/Library Contribute". 
This option has been added to make it possible for Easy Uploads to work with the German and French 
versions of WinCIM.

Users of the German version must change the option to: "German/eitrag an Bibliothek senden".
Users of the French version must change the option to: "French/Soumettre un fichier".

Show Status Bar Check Box
Enable the check box to display the Status Bar, or Disable it to Hide the Status Bar.

Start Minimized Check Box
Enable the check box to start Easy Uploads as an icon (minimized), or Disable it to start normally.

Disable Screen Saver While Open
Enable the check box to disable the Windows Screen Saver while Easy Uploads is open.    
In monitoring the CIM Support forums, I have seen messages from CIM users, and Sysops which indicate
that it's possible that a screen saver kicking in during an upload or download can cause problems.    For 
this reason I have included the ability to disable it, to avoid this potential problem. 
This option is disabled by default, and you must enable it to utilize the functionality.

Important: Easy Uploads will reset your Screen Saver option to whatever it was BEFORE you opened 
EU, as soon as you Exit EU (minimizing EU does not reset the screen save option).    So, if you want you 



utilize this function, you MUST NOT Exit Easy Uploads, until you're ready to allow the screen saver to kick
back in!    

NOTE: Personally, I never use a screen saver, for this and other reasons.    If you don't either, leave this 
check box disabled, and EU will Open and Exit 1-2 seconds faster than if it's enabled (that 1-2 seconds 
would be a waste, as it would never try to kick in anyway).    

If you do use a screen saver, and have enabled this option, you will notice that EU will Open, and Exit 1-2 
seconds slower than usual.    Unfortunately, you can't just set the ScreenSaveActive= parameter in the 
WIN.INI file to 0 to disable it, but rather must use an API call that notifies ALL applications that a system 
setting has been changed, thus requiring the additional second or two.

Easy Uploads is a Copyright of P. Scott Antony, 1995.



Run ZIP Association
Press F7, select the Upload|Run Zip Association... menu item, or the Run ZIP Association button on 
the ZIP Viewer, to pass the File Name of the current Source file to the program Associated with "ZIP" in 
File Manager.

This feature is especially useful if you use a utility like WinZIP© to maintain your Upload Archives.
With WinZIP©, and utilities like it, you can Add To, Delete From, and Temporarily Install, any Archive 
quickly and easily.

NOTE: The Run ZIP Association button on the ZIP Viewer will actually display Run , and then the actual 
Association found in your WIN.INI file.    

For example:

If your ZIP Association in WIN.INI = C:\UTILITY\PKUNZIP.EXE, then the button reads:
              R  un C:\UTILITY\PKUNZIP.EXE...

OR
If your ZIP Association in WIN.INI = C:\WINZIP\WINZIP.EXE, then the button reads:

              R  un C:\WINZIP\WINZIP.EXE...

The ellipsis (...) indicates that EU will also pass the current EU File Name to the Associated program.

Note that the ZIP Association button/menu items are Disabled if there is no Association for ZIP in your 
WIN.INI file.

See Also: Zip Source Contents

© WinZIP is a Copyright of Niko Mak Computing, Inc.
© PKUNZIP, and PKZIP are Copyrights of PKWare, Inc.

Easy Uploads is a Copyright of P. Scott Antony, 1995.



Associating Files In File Manager
When you associate a file with an application, you can open the file and start the application at the same 
time. If a file is associated with an application, there is a document-file icon next to the filename in the 
directory window. When you start File Manager, some files are already associated with applications. 

To associate a file with an application in File Manager...
1 Select the name of the file you want to associate with an application.    (Select any ZIP file)
2 From the File menu, choose Associate. 
3 In the Associate dialog box, select the application you want to associate with the file. 

If WinZIP is installed on your system, it's probably an option, otherwise, you may need to 
"Browse" for another Utility, or PKUNZIP.    When Browsing, select the actual EXE file to 
Associate.    e.g. C:\UTILITY\PKUNZIP.EXE

4 Choose the OK button. 
For help with the Associate dialog box, choose the Help button or press F1 while using the dialog box in 
File Manager. 
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File Type
The File Type List allows you to select the type of file you're uploading.    
Select from: Binary, Text, GIF, JPEG, RLE* (*CSNav only)



Spell Checking via  

If you're an MS Word, or Excel 5.x user, Easy Uploads can utilize its spell checker via OLE to 
Spell Check your Descriptions.    Simply select the appropriate Spell Check button, and wait a few 
moments while EU communicates with Word/Excel, and then away you go.    Use it just as you normally 
do.

NOTE: If Easy Uploads doesn't find Word and/or Excel on your system, the option(s) will be disabled, and
you must copy your descriptions to another application to spell check.    

You don't own Excel or Word?
If you're a CompuServe User, and of the mind, there's an excellant Freeware program called 
"Spell Checker for Edit Boxes" by Brian Quinion, which allows you to spell check data in any application's 
edit box.    I've tried it, and it works with Easy Uploads' edit boxes (description, keywords, title).    Mr. 
Quinion's description for his utility on CIS reads as follows:

Spell checker for edit boxes provides spelling checking from within any 
Windows edit box.    80,000+ word UK & US English dictionaries (UKENG.ZIP or 
USENG.ZIP - must be separately downloaded), custom dictionaries, undo, ignore all 
and a decent auto suggest are all available.    Custom dictionaries may be 
disabled, or made read only, are fully editable and can be searched for 
suggestions. Works with any application which uses standard edit controls.    This 
program will work with WinCIM, MS Access plus many others. Requires Windows 
3.1. Freeware.    

Nice job Brian!

You can find "Spell Checker for Edit Boxes" in the Windows Shareware Forum (GO WINSHARE) as 
SPELL2.ZIP (and the appropriate dictionary file: UKENG.ZIP or USENG.ZIP) in the Languages/Spell 
Check library.    The program and english dictionary archives are 82K, and 335K respectively (417K total) 
for those watching their download time.    You must download two files for this program to work (the 
program and a dictionary).

NOTE: I am in no way associated with Mr. Quinion, or "Spell Checker for Edit Boxes" (which holds all 
rights and responsibilities/support associated with the use of the program).    I only share this with you to 
help make spell checking in Easy Uploads available to everyone. In fact, Excel and Word users may find 
this utility useful for other programs, as well as its being a little faster than the OLE methods I offer, since I
have to start Word or Excel!



Save As DIZ
Select a Easy Uploads data file, and then choose Save As DIZ... (the DIZ button, or Ctrl+S) to create a 
DIZ file using the current Description. Easy Uploads will display a Save As DIZ dialog, starting with the 
directory where the ZIP is located. If you wish, you can select a different directory where the DIZ is to be 
saved, and then select OK.    Easy Uploads will display some statistics about the file it's created, and open
it with Notepad for you to edit or print if needed.    

IMPORTANT: Do NOT   change the Filename!      Select the Directory only, and then OK.    Easy Uploads 
automatically names your file, FILE_ID.DIZ; reducing the possibility of naming the file incorrectly.    If the 
file is not named FILE_ID.DIZ, it will not be read by BBS software.

DIZ files (acronym for: Description In ZIP) provide BBS's using PC Board© bulletin board software, and 
users, a way to post consistent information about your files.    The files contain a short description of the 
program that an author has written and archived with PKZIP©.    When uploaded to a BBS using PC Board
software, PC Board "looks" inside of the ZIPped file and reads the description in the FILE_ID.DIZ file and 
the description that the author has written is automatically displayed for users to read. 

In most cases, you are the one uploading your file to a BBS, however, it you've given permission for users
to further distribute, and upload to other BBS's, you can't always be sure what type of description they'll 
post for your files.    When a file is posted by someone other than the author, a BBS can opt for using the 
info in the DIZ file for the file's description.    This helps reduce the chance that you'll log onto a BBS 
someday and find your program with the description: "Really Cool Stuff", or with inaccurate and 
misleading statements.

FILE_ID.DIZ Format
The FILE_ID.DIZ file consists of straight ASCII text, up to 10 lines of text, each line being no more than 45
characters long. It should *NOT* contain any blank lines, any form of centering or formatting, or any Hi-
ASCII or ANSI characters. (e.g. it should ONLY contain alpha & numeric characters).    

Since you don't normally construct your Easy Uploads Description in DIZ format (with the Title in the 
Description) it is advised that you save your EU data file under a temporary name (e.g. FILE_ID.INI) and 
then modify it to fit the DIZ standard, before you create the DIZ file (I've create a single FILE_ID.INI file, 
and then save EVERY other EU data file over the top of it, when I want to create a DIZ file, to cut down on
the clutter. However you certainly can create a DIZ formatted data file for each of your uploads if you 
choose.

The ASP recommends that the DIZ file consist of 5 basic parts:

      1. The proper name of your program
      2. The version number
      3. The "ASP" identifier (optional, for ASP members)
      4. The description separator
      5. The description

All of the above parts should be separated by a single "space".

PROGRAM NAME: To set it apart from the rest, it is recommended that you use ALL CAPS for the 
program name.

VERSION NUMBER: The version number should be in the form of "v12.34".

ASP IDENTIFIER: If you are an ASP author, it is recommended that an "<ASP>" identifying mark be 
added after the version number, to identify your product as an ASP-authored product.



DESCRIPTION SEPARATOR: To separate the actual description text, insert a simple "-" (hyphen/minus) 
character after the ASP identifier (or version number, if not using the ASP identifier), and in front of the 
description text.

DESCRIPTION: You should attempt to FULLY describe your product, including its most important 
functions and features. Be sure to include anything which will separate your program from it's competition,
and make the BBS user want to download your file. Also try to include any hardware or software 
requirements that your product may have.

You should try to use the first 2 lines of the text to give a basic description of your program. This is helpful 
for sysops who's BBS software limits them to less than 10 lines, 45 characters. Sysops who are limited to 
using shorter descriptions can simply use the 1st two lines and truncate the rest. Thus, you can basically 
still supply your own description for BBS software which does not actually utilize the FILE_ID.DIZ feature.

The remaining lines of text can be used to elaborate on the programs features, enhancements from the 
prior version, information concerning multi-file sets. Please note that older versions of some BBS software
can only use 8 lines of text. It is advisable that you create your FILE_ID.DIZ file so that the file can be 
truncated to various line lengths without destroying it's usefulness.

Example DIZ File

EASY UPLOADS v2.00 - Save Time/$ Uploading to
CIS with WinCIM or CSNav. With Easy Uploads,
just enter all the data for your uploads
once, and then fill the Contribute dialog in
WinCIM/CSNav in seconds, time after time!
Whether you're on-line or off, EU is the
best way to help insure consistent Titles,
Keywords, and Descriptions for your files on
CIS.    Shareware - Requires WinCIM or CSNav,
and VBRUN300.DLL

*It may look like line 3 could be wider, however remember that it's displayed here in a proportional font.    
If it were a "fixed width" font like Courier, it would line up more closely with the other lines.

IMPORTANT: If your description exceeds the 450 character limit, you will be warned that it will be 
truncated.    Ifyour description is 450 characters or less, you are not guaranteed that it will all fit in a DIZ 
file.    You'll note in the example above that line 1 is only 44 characters long since adding "CIS" would 
have made the line 48 characters (3 + a space after "to"), which is past the 45 character limit.    So, after 
line 1, my maximum is down to 449, and lessens with each line that's under 45 characters.    If you want to
get as close to the 450 limit as you can, avoid using words with more than 5-6 characters, and carefully 
plan how the words are arranged.    A little rearranging can often yield better results, and more words.      
For instance, a compound word like: "WinCIM/CSNav" is better having the slash "/" replaced with a 
space, or as "WinCIM and CSNav" if it's shows at the beginning of a line, so the first word can wrap back 
a line (if it begins a line as in line 5 above, and the previous line is almost full, or it falls in the middle of a 
line with word(s) following, it would obviously make no difference, until such time as a change in a 
previous line pushed it toward the end of the line.......).
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Status Bar
Simply move the mousepointer over any area of Easy Uploads and the Status Bar will display helpful 
information related to the current object under the mousepointer.

NOTE: This method does not work for dropdown lists (both File Types, and Library lists).    To display 
status bar help for dropdown lists, select the list, or move the mousepointer over its accompanying text.

You can hide the Status Bar if you choose, by disabling its check box in the Defaults dialog.
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Upload Time Estimate
Press F11, or select the Upload|Time Estimate... menu item to display the Estimate dialog, where Easy 
Uploads will ESTIMATE the time required to upload your file(s) (based on the total file size). Estimates 
are given for 2400, 9600, 14400, 19200, and 28800 Baud.

If you want to calculate the time required to upload more than one file, you can select multiple files in the 
list by holding the Control key, and clicking with the mouse (at present, multiple selection in the File list 
only applies to the time estimate, and printing).

Since there are many factors that can influence the actual time required to upload your file, I've included a
Conversion Factor, so you can more accurately estimate the upload time based on how, when, and with 
what, You upload Your files.    

Also included is the ability to calculate the Total time of multiple uploads of the file(s). Simply enter the 
number of times you're going to upload the file(s), and let Easy Uploads do the time math.

Finally, enter the $/Hr. your BBS charges for access time to download files, and Easy Uploads will 
determine the total cost for your users, or for the download of the specified number of bytes (see below).

NOTE: The Conversion factor and $/Hr. will be saved between sessions so you don't have to remember 
them.

Estimating Download Time
To estimate the download time for a specific number of bytes, select the Download check box, and enter 
the number of bytes.    Deselecting the check box will revert the bytes, and associated Time/$ to that of 
the upload for the specified file(s).
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Search Forum Library
 (CSNav Only)

Select the Search Forum|Define Search... menu item or use Ctrl+F to Define your Search.

NOTE: The Search Forum menu item is only available when CSNav is selected as the current 'Send To'.   
I've restricted it to CSNav since WinCIM holds your search request as you move between forums, and 
therefore this option would serve little or no use in WinCIM.    

Why the Search Dialog?
Often times I find that I'd like to search many forums in my CSNav script for a particular Keyword, or File.  
As it was with the Contribute dialog, (before Easy Uploads) you're required to manually enter your search 
criteria for EACH forum in your script.    Well, NO MORE!    Now you can set your search criteria ONCE, 
and then fill in as many CSNav Search dialogs as you wish.

About the Search Dialog
The Easy Uploads 'Search Forum Library' dialog closely resembles CSNav's dialog, and should be "filled 
out" in the same manner, so I won't go into what's obvious. However, you'll notice a difference in that it 
does not contain Library selections, and adds two new option buttons.    I don't include the Library 
selection list since I seriously doubt whether a single set of selections would work with all forums as you 
go from one to the next, and would venture that most people simply choose to select All libraries for 
inclusion in the search, to cover all bases.    Although there are instances where the search needs to be 
narrowed, and hence the two option buttons which are described below.    

Using the Search Dialog
Simply enter your search criteria as you would in CSNav, and select OK to have it held in memory for the 
current session.    Then, when you want to fill out a Search dialog, simply select the Search Library... 
button in your script for the proper forum, and after it's up, tell EU to send your criteria.    This is the same 
methodology as Contributing files in that YOU must first get the dialog open, and then have Easy Uploads
send the data.    

You can send search data from the Search Forum menu, or press F12 while Easy Uploads is maximized, 
or I've also included an item in the control menu for sending search data while Easy Uploads is 
minimized.    Either way, you must first open the dialog yourself.    Once sent, Easy Uploads will do one of 
two things, depending on your selection of the following options.

Close Search Dialog When Done
Select this option to have EU enter your search criteria, and then automatically select OK to close the 
dialog. This option therefore leaves ALL Libraries selected, as they are when the dialog first appears.

Leave Search Dialog Open When Done
Select this option to have EU enter your search criteria, and then leave the Search dialog open, so you 
can individually select libraries for inclusion/exclusion in your search.    You must then manually close the 
Search dialog by selecting OK.
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 VBFile Stamper©
Select File|VBFile Stamper... or press Ctrl+T to open VBFile Stamper©.

As a compliment to Easy Uploads, I've created a Freeware utility to Date and Time Stamp files in 
Windows, called VBFile Stamper.    Even if you never use Easy Uploads again, you're free to continue 
using this Free utility.

Date/Time stamping is useful as "fake" version control for your files.    VB Programmers cannot embed 
version information in their executable, and oftentimes date and time stamp their files as the next best 
thing.    

For more information on VBFile Stamper see: VBFile Stamper Help (select the Back button when you're 
finished).

Finding VBFile Stamper
NOTE: If you've downloaded "Easy Uploads Pro", then you already have VBFile Stamper.    If not, and 
you want it, you'll need to download it separately.    Search the forum where you got Easy Uploads for 
VBFSTP.ZIP, and unzip it to your Easy Uploads directory.    It must be in your Easy Uploads directory for 
the menu item and shortcut keys to work properly.
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Custom Signatures
You can define Generic, and Time Estimate Custom Signatures for your Easy Uploads Descriptions. 
Select Options|Custom Signature... to display the definition dialog. Once defined, simply place the 
cursor in your Description where you want the signature pasted, and then select the appropriate signature
button.

 A Generic Signature is anything you repeatedly enter to your Description, and would be easier 
paste with a click of the mouse.

NOTE: If you want linefeeds before your Signature, add the linefeed symbol to your Signature definition. 
e.g. [..]Copyright 1995 by P. Scott Antony.[.]All Rights Reserved. will come out as:

end of last paragraph

Copyright 1995 by P. Scott Antony.
All Rights Reserved.

 A Time Estimate Signature is a combination of your text, and codes for the different baud rates.

Use the # symbol surrounding the baud rate to denote where you want Easy Uploads to enter the Time 
Estimate.    Your text, and the estimated times will be pasted to your Description. 
The Default Signature is: [..]DL(2400) #2400#    DL(9600) #9600#    DL(14400) #14400#    DL(19200) 
#19200#    DL(28800) #28800#.

Which, for my last version of Easy Uploads, at 271,608 Bytes, would produce:

end of last paragraph

DL(2400) 18:53      DL(9600) 04:43      DL(14400) 03:10      DL(19200) 02:22      DL(28800) 01:34 

You can see where the baud rates were enclosed in # symbols, there's now the estimated time.

NOTE: If you change the Signature, you can regain the Default by clearing the signature, and closing the 
dialog (select OK). Then Open the dialog again, and the default will be back.

Another Time Estimate Signatures might look like:

[..]Estimated Download: #2400#/#9600# @ 2400/9600 Baud.

Which would result in:

end of last paragraph

Estimated Download: 18:53/04:43 @ 2400/9600 Baud. 

Experiment, and see what looks best to you!
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ATO Script File
Easy Uploads will now create Script Files for ATO (AutoSig) Users.    Simply select one or more EU Data 
Files in the list, and select Upload|ATO Script File... (or Ctrl+F5).    

NOTE: EU will warn you if your Descriptions exceed the 6*60 (360) character limit.

When complete, you will have a fully commented file like the following.    Many features are REMed (*) out
so you can use your own scripts to get logged on, etc. and then just invoke the script when you want to 
upload.    However, if you wish to have it logon, and GO to a Forum, then remove the asterisks (*) from the
line you wish to use, and modify it appropriately.    

A GO section is provided before EACH upload so they can go to different Forums.    If they're all going to 
the same forum, then just modify the first GO if you wish, and leave the others disabled. If they're going to
multiple Forums, be sure to properly enter the GO word for EACH Forum, and adjust EACH Library 
Number!

At the end of the script is a Disabled Logoff.    If you want to Logoff after the upload, then remove the 
asterisks (*) from the lines. (Any word-wrap that may be displayed below is unintentional, and will not be 
present in the script).

* Begin Upload #1
********************************************************
* Include a 'GO' to the Forum/Library (Optional).
* Remove the asterisks, and edit the GO word to enable it.
********************************************************
*SENDLINE 'GO ???FORUM'
*MATCH '!'
*SENDLINE 'LIB 3'
*MATCH '!'
********************************************************
UPL EASYUP.ZIP /PROTO:B/TYPE:BIN|C:\EASYUP\UPLOADS\EASYUP2N.ZIP
********************************************************
* Beginning Description
MATCH 'when finished:'
PAUSE 2
SENDLINE 'Save Time/$ Uploading to CIS. Works with WinCIM AND CSNav,'
SENDLINE 'and includes a Forum Tracker, and ZIP Viewer. With Easy'
SENDLINE 'Uploads, just enter all the data for your uploads off-line,'
SENDLINE 'and then fill the Contribute dialog in WinCIM/CSNav in'
SENDLINE 'seconds, time after time! Whether you're on-line or off,'
SENDLINE 'EU is the best way to help insure consistent Titles,'
SENDLINE '/EXIT'
* Beginning Keywords
MATCH 'Keywords'
MATCH '):'
PAUSE 3
SENDLINE 'UPLOAD CIS WINCIM CIM CSNAV NAVIGATOR ZIP DIZ CONTRIBUTE'
* Beginning Title
MATCH 'Title:'

PAUSE 3
SENDLINE 'Easy Uploads v2.01 for WinCIM/CSNav'
PAUSE 3
********************************************************
MATCH '(Y or N):'



PAUSE 3
SENDLINE 'Y'
MATCH '!'
SENDLINE 'LIB 3'
MATCH '!'
********************************************************
* End of Upload #1
*
* Begin Upload #2
********************************************************
* Include a 'GO' to the Forum/Library (Optional).
* Remove the asterisks, and edit the GO word to enable it.
********************************************************
*SENDLINE 'GO ???FORUM'
*MATCH '!'
*SENDLINE 'LIB 3'
*MATCH '!'
********************************************************
UPL ESYPRO.ZIP /PROTO:B/TYPE:BIN|C:\EASYUP\UPLOADS\EASYUP2P.ZIP
********************************************************
* Beginning Description
MATCH 'when finished:'
PAUSE 2
SENDLINE 'PRO adds FREE VBFile Stamper, and Time Estimator.  Save'
SENDLINE 'Time/$ Uploading to CIS. Works with WinCIM AND CSNav, and'
SENDLINE 'includes a Forum Tracker, and ZIP Viewer. With Easy'
SENDLINE 'Uploads, just enter all the data for your uploads once, and'
SENDLINE 'then fill the Contribute dialog in WinCIM/CSNav in seconds,'
SENDLINE 'time after time! Whether you're on-line or off, EU is'
SENDLINE '/EXIT'
* Beginning Keywords
MATCH 'Keywords'
MATCH '):'
PAUSE 3
SENDLINE 'UPLOAD CIS WINCIM CIM CSNAV NAVIGATOR ZIP DIZ CONTRIBUTE'
* Beginning Title
MATCH 'Title:'
PAUSE 3
SENDLINE 'Easy Uploads v2.01 PRO for WinCIM/CSNav'
PAUSE 3
********************************************************
MATCH '(Y or N):'
PAUSE 3
SENDLINE 'Y'
MATCH '!'
SENDLINE 'LIB 3'
MATCH '!'
********************************************************
* End of Upload #2
*
********************************************************
* Include an 'Exit' from CompuServe (Optional)
* Remove the asterisks to enable it.
********************************************************
*EXIT Z
*^M
********************************************************



* End of Script
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 Easy Uploads Scripting
Just a little peek now...

Look for its release in coming weeks...
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